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Revision History

The following table shows important changes made in this document for each revision.

Revision Changes

Revision 1 Initial release.

(Nov 2016)

Revision 2 Added PolarFire support and minor updates
(May 2017)
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1 Introduction

The Netlist Viewer is a graphical representation of the design netlist. As FPGA designs grow in size and
complexity, it has become essential for the FPGA designer to traverse the netlist to analyze the design.

Available for PolarFire, SmartFusion2, IGLOO2, and RTG4 families, the Microsemi Netlist Viewer is a
graphical user interface that displays different views for the different stages of the design process:

*  RTL Netlist View - Technology-independent netlist view of the design before mapping of the
design elements to the Microsemi-specific technology. Using the RTL view is a fast and easy
way to determine whether the correct logic has been implemented by the software. Cross-
probing from this view to the HDL code facilities troubleshooting when the design is not working
as desired.

»  Post-Synthesis Hierarchical View - Hierarchical view of the netlist after synthesis and after
technology mapping to the Microsemi FPGA technology.

+ Post-compile flattened Netlist View - A flattened netlist after synthesis, technology mapping and
further optimization based on the DRC rules of the device family and/or die.

Figure 1+ Netlist Viewer - RTL View
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Figure 2 » Netlist Viewer - Hierarchical View
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Figure 3 » Netlist Viewer - Flattened View
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Note: A progress bar pops up to indicate the flattened netlist is being loaded. For a large netlist, the loading
may incur some runtime penalty. A Cancel button is available to cancel the loading.

Revision 2 7



Invocation Q Microsemi

Power Matters.”

2 Invocation

The standalone Netlist Viewer is available for invocation in the Design Flow window.
To open the standalone Netlist Viewer in the Flow Window, do one of the following:

«  Double-click Netlist Viewer inside the Design Flow window.
* Right-click Netlist Viewer and select Open Interactively (Netlist Viewer > Open Interactively)

Figure 4 » Netlist Viewer Invocation - Design Flow Window
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When Netlist Viewer opens, it makes available for loading and viewing the following views of the netlist:
* RTL Views - Available after design capture/design generation
« Hierarchical Post-Synthesis - Available after Synthesis
. Flat Post-Compile - Available after Synthesis or Place and Route. If after Place and Route, the
Netlist Viewer loads the Flat Post-Compile view to reflect the netlist generated after Place and

Route.
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3 Netlist Viewer Windows

When the standalone Netlist Viewer opens, no netlist views are loaded.The Start Page displays what

netlist views can be opened for viewing.

The Netlist Viewer User Guide is available from the Help menu (Help > Reference Manuals)

3.1  Opening a View

Click any one of following views (across the top left corner) to load the netlist into the Netlist Viewer for

viewing:

. RTL view

*  Hierarchical Post-Synthesis view

Note:Not available if synthesis is disabled in the design flow (Project > Project Settings > Enable

Synthesis is unchecked)

*  Flat Post-Compile

view

Figure 5 « Nelist Viewer on Start Up
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Netlist Viewer

The Netlist Viewer provides an easy-to-use interface for viewing and navigating through a graphical
representation of your design’s netlist. To learn more about the various supported features refer to the user

guide found at: http://coredocs.s3.amazonaws.com/Libero/11 8 0/Tool/stdalone_nlv_ug.pdf

Getting Started:

To start using the Netlist Viewer select one of the three view buttons from the top-left of the screen. The RTL,
Hierarchical Post-Synthesis, and Flat Post-Compile views let you view your design’s netlist at different stages of
the design flow.

Views:

RTL: The RTL view shows the design as described in the HDL or SmartDesign generated source files. It does not
require the synthesis nor compilation step in order to be viewed. This view supports crossprobing items to their
location in the HDL source files.

Hierarchical Post-Synthesis: The Hierarchical view shows the design after it has gone through synthesis. This
view supports crossprobing items to their location in the post-synthesis netlist. This view is only available after

rumming cunthacic in tha likara dncioen flaa

1

|Mode: — | Current Level: — | Current Page: — [Fam: 16L002

Note: When netlist views are opened for the first time in the Netlist Viewer, they are first loaded into the system
memory and stay in the system memory until the Netlist Viewer exits. For very large designs, loading the

netlist for the first time may incur some runtime penalty. A pop-up window reports the status of the

loading process.
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Figure 6 « Pop-up Window
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When the netlist views are opened for the second and subsequent times, the netlist views are available

almost immediately in the Netlist Viewer because they are already loaded into the system’s memory.

Closing a View

Click any opened view (across the top of the Netlist Viewer) to close any opened view. A closed view
stays in the system memory as long as Netlist Viewer remains open. Opening the same netlist view at a

later time does not incur runtime penalty as no loading is required.

Netlist Viewer Windows

When the Netlist Viewer opens, it displays three windows by default:

+ Design Tree window - displays the design hierarchy from the top level
+ Canvas Window - displays the netlist views
*  Log Window - displays messages/warnings/Info etc.

Figure 7 » Netlist Viewer Windows
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Loading RTL source files: Log Window
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Ready Mode: Global |Current Level: TOP_LEVEL (TOP) |CurrentPage: 1of 1 |Fam: 16LOO2

Design Tree Window

This Window displays the design hierarchy from the top level. By default, when the Netlist Viewer opens,

it displays the Design Tree window.

The Design Tree window is displayed on default when the Netlist Viewer opens. Hiding the Design Tree
view will leave more display area for the Canvas view. To get a bigger display area for the canvas view,

hide the Design Tree Window (Netlist Viewer > Windows > Uncheck Show Tree)

The Design Tree window displays:
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Nets (<interger>) - the number in brackets is the total number of nets at the top level.

Ports (<integer>) - the number in brackets is the total number of ports at top level

Design components under the top level - each component can be collapsed or expanded to expose
* nets - total number of nets at the component level

*  ports - total number of ports at the component level

*  sub-components inside the component

Fanout Values (Nets) - When two numbers are displayed in the bracket, the first number is the
fanout of the net at the local level (of hierarchy) and the second number is the fanout of the net at the
global level. As an example, net_xyz (fanout:1,3) means the net goes down the levels of hierarchy to
three different pins (global fanout 3) and is not connected to any other pins at the current level (local
fanout 1).

Primitives - Primitives refer to macros and low-level design objects and can appear in the top level or
component level.

The design tree is different with different netlist views. For the Flat Post-Compile view, the design tree
displays a much bigger number of nets than the RTL or Hierarchical Post-Synthesis view because the
netlist is flattened in the Post-Compile view and all nets are counted. The nets in the Flat Post-Compile
view, unlike the RTL view or the Hierarchical Post-Synthesis view, shows only one value for fanout

(global fanout) because it is a flattened view (no hierarchy).

For the nets that are part of a NetBundle, the NetBundle name is followed by a number in parenthesis
that indicates the total number of nets in the NetBundle.

Figure 8 » Design Tree Window
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3.41 Filter

The display of design objects in this view can be filtered based on:
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* Ports - displays all ports only, including component level ports

* Nets - displays all nets only, including component level nets

* Instances - display all instances only, including component level instances
*  Modules - display all modules only

»  Filter All - display all design objects only

*  Use Wildcard Filter

*  Use Match Filter

*  Use Regular Expressions

Click the Filter button at the top right corner of the Design View to filter design objects.

5 | Netlist Viewer - TOP LI

File Windows Help

Hierarchical Post-Synthesis [ Flat Post Complle

Design View

[ StartPage | Netist Viewer - Flat Post-Complle | Netist Viewer -RTL
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AHBL_MASTER_0 (285)
APB3_S_DPSRAM_0 (365)

flash_freeze_inst (1)

Filter Ports %

Use Match Filter
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3.4.2 Interoperability Between Windows and Views

When a design object such as a net, an instance or a port, is selected in the design tree window, the
object is selected in the different netlist views. The reverse is also true. An object selected in one netlist
view window is also selected in the design tree window and other netlist views.

Interoperability works only when the Toggle Crossprobing icon is enabled.

3.5 Canvas Window

The Canvas Window displays the:

*+ RTL view

»  Hierarchical Post-Synthesis view

*  Flat Post-Compile view

+  Cones view

*  Opened HDL files (not available in the Flat Post-Compile view)
»  Start Page - when no netlist views are opened

When a view is opened, a view tab is added across the top of the Canvas Window for ease of switching
among the different views.

Note: To get a bigger display area for the Canvas view, hide the Design Tree Window (Netlist Viewer >
Windows > Uncheck Show Tree) and hide the Log Window (Netlist Viewer > Windows > Uncheck
Show Log). Hiding the Log window and the Design Tree window leaves more display area for the
Canvas window. Alternatively, press CNTL+w to maximize the work area.
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Inside the canvas window, there is a list of icons across the top of the window for the user to

»  Traverse vertically up (Pop) or down (Push) the design hierarchy

* Navigate horizontally across different pages of the design view

«  Zoom in/out of the design view
«  Trace critical nets to the driver/load
*  Create logical cones for debugging

»  Control the color display of the design objects in the Canvas Window

1. See the Netlist Viewer Interface User Guide for details.

Figure 10 + Canvas Window
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3.6 Log Window

The Log Window displays the following:

* Informational messages such as the location and name of the files used to display the view
+  Syntax errors, if any, in the HDL file if the HDL file is opened with the “Open File Location” option

(Right-click design object > Open File Location).

Revision 2
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Note: The Log window is displayed on default when the Netlist Viewer opens. Hiding the Log window will leave
more display area for the Canvas view. To get a bigger display area for the canvas view, hide the Log
window (Netlist Viewer > Windows > Uncheck Show Log)

Figure 11+ Log Window
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Tia AWMl iMTIT TT mmmawd 2 (CUTT N7 IWMNET DEWA asmmanmne Il aea] T wnaefann (Pann AURTS4m /0 A 100 iwe] frrkd] fnmws fnsmmansnea rnd

Ready Mode: Global | Current Level; TOP_LEVEL (TOP) |CurrentPage: 1of 1 |Fam: IGLOOZ

3.7 Status Bar

The status bar at the bottom right corner of the Netlist Viewer displays the following:

*  Mode - Either Global or Local mode is displayed. Global mode means the Netlist Viewer can cross
hierarchical boundaries when following nets to drivers or loads. Local means the Netlist Viewer stays
in the current level of design hierarchy.

«  Current Level - displays the current level of design hierarchy, either TOP_LEVEL instance name or
instance name of the component.

»  Current Page - displays the current page of the Netlist Viewer (Page x of <total>) when traversing
across different pages of the Netlist Viewer.

+ Fam - displays the technology family.

Figure 12 « Status Bar
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Product Support

A1

4.2

4.3

4.4

4.5

4.5.1

4.5.2

Microsemi SoC Products Group backs its products with various support services, including Customer
Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices.
This appendix contains information about contacting Microsemi SoC Products Group and using these
support services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

From North America, call 800.262.1060
From the rest of the world, call 650.318.4460
Fax, from anywhere in the world, 408.643.6913

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled
engineers who can help answer your hardware, software, and design questions about Microsemi SoC
Products. The Customer Technical Support Center spends a great deal of time creating application
notes, answers to common design cycle questions, documentation of known issues, and various FAQs.
So, before you contact us, please visit our online resources. It is very likely we have already answered
your questions.

Technical Support

For Microsemi SoC Products Support, visit
http://www.microsemi.com/products/fpga-soc/design-support/fpga-soc-support.

Website

You can browse a variety of technical and non-technical information on the Microsemi SoC Products
Group home page, at http://www.microsemi.com/products/fpga-soc/fpga-and-soc.

Contacting the Customer Technical Support
Center

Highly skilled engineers staff the Technical Support Center. The Technical Support Center can be
contacted by email or through the Microsemi SoC Products Group website.

Email

You can communicate your technical questions to our email address and receive answers back by email,
fax, or phone. Also, if you have design problems, you can email your design files to receive assistance.
We constantly monitor the email account throughout the day. When sending your request to us, please
be sure to include your full name, company name, and your contact information for efficient processing of
your request.

The technical support email address is soc_tech@microsemi.com.

My Cases

Microsemi SoC Products Group customers may submit and track technical cases online by going to My
Cases.
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4.5.3

4.6

Power Matters.”

Outside the U.S.

Customers needing assistance outside the US time zones can either contact technical support via email
(soc_tech@microsemi.com) or contact a local sales office. Visit About Us for sales office listings and
corporate contacts.

ITAR Technical Support

For technical support on RH and RT FPGAs that are regulated by International Traffic in Arms
Regulations (ITAR), contact us via soc_tech@microsemi.com. Alternatively, within My Cases, select Yes
in the ITAR drop-down list. For a complete list of ITAR-regulated Microsemi FPGAs, visit the ITAR web

page.
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